
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AMS111 
  
 
 
 
 
 

AWS Service 
 

Version: 2 
 
 

 
 

 User’s Guide 
 

 
 
 April 2015 
 
 
 
 
 
 
 
 
 

s
o

lu
ti

o
n

s
  

fo
r 

th
e
 r

e
a
l 

w
o

rl
d

 

www.microstep-mis.com 



 
© Copyright 2015, by MicroStep-MIS 
 
All rights reserved. No part of this publication may be reproduced, stored in retrieval system, or 
transmitted by any means, electronic, mechanical, photocopying, recording, or otherwise without the 
prior written permission of MicroStep-MIS. 
 
Trademarks 
 
Windows is a registered trademark of the Microsoft Corporation. 
All other trademarks or registered trademarks mentioned belong to their respective owners. 

 
Version of edition 
 
Version of edition: 1.6A 
Date of the edition: 2015-04-10 

 
Authors 
 
Editorial team: Mr. Csaba Ruman, MicroStep-MIS 
 
Address  
 
MicroStep-MIS 
Monitoring and Information Systems 
Čavojského 1 
84104 Bratislava 4 
Slovakia 
Tel.: +421 2 602 00 100 
Fax: +421 2 602 00 180 
info@microstep-mis.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MicroStep-MIS develops, manufactures and markets monitoring and information systems. The key 
fields of our activities are meteorology, aviation, environmental sciences, seismology, power 
engineering, civil defense but also information systems in tourism. 
 
MicroStep-MIS operates worldwide. Our core customer groups are airports, meteorological and 
seismological institutes, environmental authorities, industry, power stations and electricity distribution 
companies. 
 

mailto:info@microstep-mis.com


 
 
 
 

     

 

-2- 

  
AWS Service – User’s Guide 

    
 
 
 
 
 

 

Web-site   www.microstep-mis.com E-mail   info@microstep-mis.com 

 

Table of contents 
 
Table of contents ..................................................................................................................................... 2 
Typographical conventions ...................................................................................................................... 3 
1. Introduction ..................................................................................................................................... 4 
2. Installation ....................................................................................................................................... 4 

2.1 System requirements ............................................................................................................. 4 
2.2 Installation .............................................................................................................................. 4 

3. Using AWS Service......................................................................................................................... 7 
3.1 Connect to data logger ........................................................................................................... 8 

3.1.1 USB Connection ................................................................................................................ 8 
3.1.2 Serial Port Connection ....................................................................................................... 9 
3.1.3 Network Connection ........................................................................................................ 10 
3.1.4 Open connection from file ................................................................................................ 12 
3.1.5 Save connection to file ..................................................................................................... 13 
3.1.6 Close the connection ....................................................................................................... 13 

3.2 Configure station .................................................................................................................. 14 
3.2.1 Automatic Identification .................................................................................................... 14 
3.2.2 Select station ................................................................................................................... 15 
3.2.3 Select configuration version ............................................................................................. 15 
3.2.4 Execution of configuration steps ...................................................................................... 15 
3.2.5 Manually set variables ..................................................................................................... 16 

3.3 Backup configuration ............................................................................................................ 18 
3.4 Restore configuration ........................................................................................................... 20 
3.5 Advanced access ................................................................................................................. 21 

3.5.1 Clear console ................................................................................................................... 21 
3.5.2 Show Protocols command ............................................................................................... 21 
3.5.3 Version command ............................................................................................................ 21 
3.5.4 Task info command ......................................................................................................... 21 
3.5.5 Get date command .......................................................................................................... 22 
3.5.6 Set date command ........................................................................................................... 22 
3.5.7 Restart data logger .......................................................................................................... 23 
3.5.8 Terminal ........................................................................................................................... 23 

3.6 File Manager ........................................................................................................................ 24 
3.6.1 Send or receive files ........................................................................................................ 24 
3.6.2 Receive configuration ...................................................................................................... 25 
3.6.3 Send configuration ........................................................................................................... 25 
3.6.4 Reload data logger files ................................................................................................... 25 
3.6.5 Delete files ....................................................................................................................... 25 
3.6.6 Rename file ...................................................................................................................... 25 
3.6.7 Copy file ........................................................................................................................... 25 

3.7 Measurements ..................................................................................................................... 26 
3.8 Station list ............................................................................................................................. 27 

3.8.1 Add station / Edit station .................................................................................................. 27 
3.8.2 Edit configuration types ................................................................................................... 28 
3.8.3 Add/Edit configuration type .............................................................................................. 29 
3.8.4 Edit configuration versions ............................................................................................... 29 
3.8.5 Add configuration version ................................................................................................ 30 

3.9 Update firmware ................................................................................................................... 31 
3.10 Communication .................................................................................................................... 33 
References ........................................................................................................................................ 34 



 
 
 
 

     

 

-3- 

  
AWS Service – User’s Guide 

    
 
 
 
 
 

 

Web-site   www.microstep-mis.com E-mail   info@microstep-mis.com 

 

Typographical conventions 
 
Throughout this guide, several typographical conventions are used to help reader to follow instructions 
and identify the important information. 
 
Items from graphical user interface: 
 
 Button Settings, File > Exit, …  
 
Filenames, directories, commands: 
 

 200911.LOG, C:\AWSService\, …  

 
Note, attention, warning: 
 

Note: If you have associated the .tgz file extension with the AWS Service in Windows, then 

the configuration process starts after double clicking the compressed configuration file. 
  
Attention: If any parameter from the top is set to Default, the parameters below it will be ignored. 
 
Warning: By removing the configuration type, it will also remove the stations associated with this 

configuration type and their backups! 
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1. Introduction 
MicroStep-MIS data loggers (AMS 111, AWS 111, AWS 200) measure, process and store various 
measured quantities. Some models of the data loggers are equipped with LCD display (AWS 111) or 
with touch-screen display (AMS 111), where currently measured values can be seen. 
 
AWS Service is software used to maintain data loggers. 
It allows you to: 

• configure station and back-up configuration of station automatically, 

• display and transfer files on data logger,  

• show and change variable values 

• execute commands 

• update firmware 
 

2. Installation 

2.1 System requirements 
Minimum system requirements: 
 
CPU: 1 GHz 
RAM: 512 MB 
OS:  Microsoft Windows 7 or higher 
Framework: .NET Framework 4.6.2  
 

2.2 Installation 
 

Run AWS_Service_installer.exe to start installation. Administrator privileges are required. You 

will be prompted to choose installer language. 
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Choose destination folder, then click next. 
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Choose start menu folder, then click Install. 
 
 

 
 
 
After wizard completes installation, you can run program and create desktop shortcut by selecting 
checkboxes and clicking Finish button. 
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3. Using AWS Service 
To Start AWS Service application on your computer click on shortcut in start menu or launch 

AWSService.exe file and wait until the Main Screen appears. Every function is accessible by the 

icons. First 3 icons (Configure, backup and restore) are intended for manage data logger’s 
configuration. The Advanced access provides direct access to data logger. 
 

 
 

Main menu can be accessed by clicking the Main menu  button. You can return to Main Screen 
from any screen by the first option in menu: Home. If the home menu is not accessible, it means that 
the current screen cannot be closed, because it has to finish the current operation. 
 

 
 
The Close connection menu closes and forgets the last used communication channel. 
The Leave station menu forgets the lastly used station. It is useful if you have multiple stations close 
to each other and you want to configure each without closing the serial port. Then the connection may 
remain open, but another station can be selected after you are connected to different station. 
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3.1 Connect to data logger 
Some parts of program require connection to the data logger. If the connection is required, the AWS 
Service will show the following screen.  
 

 
 
You can choose these types: 

• USB cable 

• Serial port 

• Network 

• Open file 
 
The Open File option enables you to open Serial port or Network type, if it was previously saved to 
connection file. 
 
The selection of the connection will not be prompted further if the connection is alive. 

3.1.1 USB Connection 

The program will detect if there is a data logger connected with USB connection. If the data logger is 
not recognized within few seconds, you should disconnect the USB cable and connect it again to 
computer. 
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3.1.2 Serial Port Connection 

To connect to data logger through serial port you have to know the Port Name of this interface. 
Before proceeding you should pass the basic test of connection. You can also change the other 
parameters of the connection too. The predefined settings are the factory default parameters of the 
data logger. These are the following: 
Baud Rate – 9600 
Data Bits – 8 
Parity – None 
Stop Bits – 1 
Handshake – None 
 

 
 
Click Test button to perform a test. It will try to open the chosen port and detect whether a data logger 
is connected and responding. 
 
Note: You can not continue until a test of connection has not been performed. The majority of 

connection errors happen because of wrong settings (e.g. wrong Port selected). This 
screen is the best place to test whether the connection works. 
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If the connection is opened on another line of the data logger, you can force to close that line and 
open this connection. 
 
If the data logger does not respond, you can try another serial port, or try to change the parameters of 
the connection. If the connection is very slow (response time more than 5 seconds, e.g. modem 
connection) then you can check Open anyway even if the data logger does not respond. In this case 
you can continue, but the response from data logger is not guaranteed. 
 

 
 
Once you get a functional connection, you can Save it to file, to be able to open it quicker in future.  

3.1.3 Network Connection 

In order to use a network connection, the data logger has to be already set up for networking. If your 
data logger is not connected to the network, choose Serial Port or USB options instead. (Use Back 
button to the previous screen) 
Be careful about configuring the data logger through network, because by wrong settings you can lose 
further access from network. The serial line or USB options will remain accessible even in case of 
misconfiguration. 
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Click Test button to perform a test. It will try to open the entered TCP connection and detect whether a 
data logger is connected and responding. 
 

 
 
If the connection is opened on another line of the data logger, you can force to close that line and 
open this connection. 
 
If the data logger does not respond, you can try another network port (if the data logger is configured 
to handle multiple ports). If the connection is very slow (response time more than 5 seconds, e.g. 
modem connection) then you can check Open anyway even if the data logger does not respond. In 
this case you can continue, but the response from data logger is not guaranteed. 
 

 
 
Once you get a functional connection, you can Save it to file, to be able to open it quicker in future.  
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3.1.4 Open connection from file 

To open a previously saved connection, select it from the list. You should pass a basic test whether 
the communication line can be opened or not and whether the data logger responds to commands. 
To perform this test, click the Test button. It will try to open the saved connection and detect whether a 
data logger is connected and responding. 
 

 
 
If the connection is opened on another line of the data logger, you can force to close that line and 
open this connection. 
 
If the data logger does not respond, you can try another saved connection. If the connection is very 
slow (response time more than 5 seconds, e.g. modem connection) then you can check Open 
anyway even if the data logger does not respond. In this case you can continue, but the response 
from data logger is not guaranteed. 
 

 
 
If the connection is established, you can continue by clicking the Next button.  
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3.1.5 Save connection to file 

In Serial Line and Network options you can save the entered connection parameters to file. Click on 
the Save icon on toolbar, or select File > Save Connection from main menu and then enter the file 
name to save. The file will be saved to location that can be edited in Tools > Options menu. 
 

 

3.1.6 Close the connection 

In order to close the connection, you have to leave any screen which uses the connection. Select the 
Home button in menu 
 

 
 
If you are already on the home screen, you can select Close connection. 
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3.2 Configure station 
Data logger’s configuration is application software which differs from station to station. Configurations 
are created using AWS Setup program. Please refer to AWS Setup User’s Guide [2]  for creation of 

data logger configurations. The AWS Setup program creates a compressed .tgz file with all the 

necessary files needed for defining the data logger behavior.  
 
Note: The data logger’s configuration is different from the data logger’s firmware. The 

configuration is created by user (system integrator) and varies from station to station, 
whereas the firmware is created by MicroStep-MIS and it is common for all data loggers. 

 
 
The Configure station option is intended for updating the configuration to newest version or for 
overwriting the configuration of the data logger with the default settings. It is a wizard which navigates 
you through the steps of configuration. Before configuration we recommend to create a backup 
(chapter 3.3) 
 

Note: If you have associated the .tgz file extension with the AWS Service in Windows, then 

the configuration process starts after double clicking the compressed configuration file. 
 
The configuration process consists of few steps: 
 

1. Open the connection to the data logger 
2. Choose the station and a version of configuration. This step is skipped when configuration 

was opened from the file (because we know exactly which version should be used). This step 
consists of these sub-steps: 

a. Automatic identification 
b. Manual selection of station (with preselected default from previous step) 
c. Selection of version (with preselected default of the newest version) 

3. Execution of configuration steps 
4. Manual definition of selected variables (Optional) 

 
Note: If the connection is already open, then the first step is skipped. Similarly if the station is 

already remembered, then the second step is also skipped. To change the station in this 
case, select Leave Station from Main menu and repeat the process. 

 
For opening the connection please refer to chapter 3.1. 
 

3.2.1 Automatic Identification 

In this step the software will try to select the right station depending on the database of Station 
identifications (defined in chapter 3.8.1) and the actually stored value in the data logger’s variable. 
If it matches a station, it will be selected in the next step. Otherwise, you can select another station 
manually in the next step.   
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3.2.2 Select station 

If the automatic identification was successful, the first station is the detected station and it is selected 
by default. If you think that this station is not the right station, you may select another one or Add a 
new station which is not listed in the list. 
 
 

 
 
 

3.2.3 Select configuration version 

In this view you can select historical versions of configuration file, but by default always the newest 
version is selected. If the right version is not in the list, you can add a new version. 
 
Note: The newly added configuration version will be available for all stations which share the 

common station type, not just for the actually selected station. 
 
Note: The removed configuration version will be removed for all stations which share the 

common station type, not just for the actually selected station. 
 

 
 

3.2.4 Execution of configuration steps 

The configuration steps are defined in the .tgz configuration file (or configuration version). The 

configuration steps are shown below the buttons in a list. These steps can be started automatically by 
clicking the Start button. The progress will be shown next to the Cancel button. To abort the 
configuration, you can use Cancel button.  
If you don’t want to execute all of these steps, you can Run the steps individually. Each configuration 
step indicates a progress ring when it is executed or waiting for execution. The result of the step is 
shown next to the indicator. If the step was successful, it is marked by green tick  sign. Failed steps 
are marked with red cross  sign. You can repeat failed steps by clicking on the Run button. 
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Attention: The list of steps is scrollable. In some cases you need to check whether all of the steps 

were successfully executed, but not all fits the screen. 
 

 
 

 
 
You can continue to next step after it is finished with all of the steps, or you can continue even without 
performing any action. 
 

3.2.5 Manually set variables 

Some variables differ from station to station, some variables have to be set on the installation place, 
and therefore it is impossible to create a universal configuration. These variables can be set manually 
on the last step of the configuration. 
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Attention: The list of variables is scrollable. In some cases you need to check whether all of the 

variables were successfully set correctly, but not all fits the screen. 
 
 
In each row there is an editable text box, which shows the actual value of the variable (name is above) 
There are 3 buttons: 
The Set button will write the content of the text box into the variable in data logger.  
The Read button will read the value of the variable and show it in the editable text box.  
The Default button will overwrite the actual value by the default value defined in the configuration file. 
 
The images after the buttons describe whether the command is working or not (working: progress ring, 
not working: none) and the result of the last command: 

• Green tick  sign: Command executed and the value in the text box corresponds to the 
variable in the data logger. 

• Red cross  sign: Command not executed and the value in the data logger is not known. 

• No sign: unknown state, variable not changed 
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3.3 Backup configuration 
Station state can be backed up into the database of the computer. These backups can be later used to 
restore the configuration of system.  
 
Warning: Backups do NOT include log files. Backups are just for configuration. Log files should be 

backed up differently. For example copy the contents of internal SD card to an external 
one. Or when replacing the data logger, just simply replace the SD card from old data 
logger to new one. 

 
Backup is a reverse configuration process. That means that state of every step during the 
configuration is retrieved from the data logger and stored in the database. Only that kinds of 
information are stored, which are required for the current configuration type. This is the reason why 
the program should know about the configuration version. 
 
Backup process follows these steps: 

1. Open the connection to the data logger 
2. Identify the station 
3. Select the station from the list (previously identified station is automatically selected) 
4. Select a version of the actually used configuration (skipped if there is only one version 

defined) 
5. Enter a short name of backup and optionally a longer description with more details. 
6. Start the backup process 

 
Note: If the connection is already open, then the first step is skipped. Similarly if the station is 

already remembered, then the second and third steps are also skipped. To change the 
station in this case, select Leave Station from Main menu and repeat the process. 

 
For opening the connection please refer to chapter 3.1. 
 

 
 
Enter a short Name which will mark the backup, so you can distinguish the stored backups. The 
Description is not needed, but we recommend entering the details, why are you creating the backup. 
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Click the Start button to start the backup process. When successfully finished, a “Configuration is 
successfully backed up” message appears. If there were errors, then this message does not appear 
until every step is not successful. You can repeat the failed steps by clicking Run button. Once all 
steps show green tick, the “Configuration is successfully backed up” message will appear. 
 

 
 
You can continue to Main screen by clicking Next button. 
The backups are stored in the database in the computer. You can use them to restore configuration. 
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3.4 Restore configuration 
Restore configuration is in fact the same process as the configuration (described in chapter 3.2). The 
main difference is that it does not use the default configuration files, but the files created during 
backup. Manually configurable variables are in this step configured automatically depending on the 
state of the backed up variables, so the restoration process can be fully automatic.   
 
The restoration process consists of few steps: 
 

1. Open the connection to the data logger 
2. Identify the station 
3. Select the station from the list (previously identified station is automatically selected) 
4. Choose a backup 
5. Execution of configuration steps 
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3.5 Advanced access 
In advanced access you can write commands directly to the operating system of the Data Logger. 
There are some predefined commands on left side of screen. Custom commands can be entered into 
smaller text box under the console. Commands are sent to data logger by clicking Send button or by 
Enter key. 
There are three modes which are selectable by buttons: Command, Terminal and Manual. Most of 
preprogrammed functions requires Command mode. 
 

 
 

3.5.1 Clear console 

Clear console command clears the output screen. Click on the Clear console button to perform this 
command. 
 

3.5.2 Show Protocols command 

Protocols command shows actual list of reports logged by each running task. Basic message informs 
about logger startup status. Click on the Protocols button to perform this command. 
 

3.5.3 Version command 

Version command shows actual version of the data logger firmware. Click on the Version button to 
perform this command. 
 
VER 

ML-UNI 1.1C 

MicroStep-MIS 

August 2003 

 

3.5.4 Task info command 

This command provides detailed information about running tasks status. Task info command shows 
status for all running tasks. It displays how many tasks are currently running at the system and how 
much time was dedicated to “IDLE task” (i.e. no activity task). All other tasks have calculated their 
processor time and information about the stacks. Click on the Task info button to perform this 
command. 
 
SystemT:  21:58:26.938 100.00000%  0.00000% FreeStack:3608 UsedStack:  12% 

   Idle:   0:12:19.299  0.93456%  0.00000% FreeStack:1440 UsedStack:   6% 

 0.Task:   0:00:00.273  0.00035%  0.00000% FreeStack:1192 UsedStack:  22% 

 1.Task:   0:04:01.255  0.30497%  0.00000% FreeStack:0968 UsedStack:  37% 

 2.Task:   0:01:30.185  0.11400%  0.00000% FreeStack:0952 UsedStack:  38% 

 3.Task:  20:39:28.702 94.01035%  0.00000% FreeStack:1360 UsedStack:  28% 

 4.Task:   0:08:35.561  0.65173%  0.00000% FreeStack:1356 UsedStack:  11% 

 5.Task:   0:00:00.002  0.00000%  0.00000% FreeStack:1344 UsedStack:  12% 

 6.Task:   0:06:27.907  0.49036%  0.00000% FreeStack:1372 UsedStack:  10% 

 7.Task:   0:00:06.646  0.00840%  0.00000% FreeStack:0840 UsedStack:  45% 

 8.Task:   0:08:01.139  0.60821%  0.00000% FreeStack:1188 UsedStack:  22% 

 9.Task:   0:00:22.811  0.02884%  0.00000% FreeStack:1260 UsedStack:  18% 

10.Task:   0:00:06.740  0.00852%  0.00000% FreeStack:1128 UsedStack:  26% 

11.Task:   0:00:20.947  0.02648%  0.00000% FreeStack:1192 UsedStack:  22% 

12.Task:   0:00:22.478  0.02841%  0.00000% FreeStack:1032 UsedStack:  33% 
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13.Task:   0:00:01.397  0.00177%  0.00000% FreeStack:1096 UsedStack:  28% 

14.Task:   0:00:12.822  0.01621%  0.00000% FreeStack:1304 UsedStack:  15% 

15.Task:   0:01:22.956  0.10487%  0.00000% FreeStack:0760 UsedStack:  51% 

16.Task:   0:00:28.626  0.03619%  0.00000% FreeStack:1136 UsedStack:  26% 

17.Task:   0:01:35.673  0.12094%  0.00000% FreeStack:1352 UsedStack:  12% 

18.Task:   0:00:26.788  0.03386%  0.00000% FreeStack:0936 UsedStack:  39% 

19.Task:   0:02:42.426  0.20532%  0.00000% FreeStack:1344 UsedStack:  12% 

OffTime:   0:00:00.000  0.00000%  0.00000% 

RtxExec:   0:29:52.305  2.26567%  0.00000% FreeStack:1424 UsedStack:   7% 

IntLate:0 MemFreeAll:21819 MemFreeBlkMax:21819 MemFreeBlkCount:1. 

OK 

 

3.5.5 Get date command 

Click Get date button to display actual date and time in data logger in the console. 
 

3.5.6 Set date command 

Click Set date button to open Set Date and Time dialog.  
 

 
 

In this dialog you can see the actual time in the data logger and the time which you are going to set. 
To change this time, there are few options: 
 
Custom time – when checked, you can enter any custom time to data logger. To define a date and 
time, use the selector below this check box.  
When the custom time is not checked, the time will be the actual time of the computer. 
 
UTC time – when checked, the Universal Coordinated Time will be set. This is the basic time on Earth 
and the different time zones can be calculated from this time (e.g. by the data processing server).  
If the UTC time is not checked, it will use the local time zone of the computer. 
 
Note: If your time zone uses daylight saving time, the data logger will not use it to avoid data 

confusion. It will always use standard time. 
 
After the settings, you can set the time by clicking the Set date button. 
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3.5.7 Restart data logger 

Command Restart causes software restart of the data logger.  
 
Note: The Restart command can be even used to restart the logger remotely (via modem). Any 

changes in the configuration and software performed before logger reset will take 
effect, therefore in case of misconfiguration the logger may stop answering. 

 

3.5.8 Terminal 

Terminal mode is direct connection to data logger’s serial port (pass-through mode) or to command 
line interpreter of data logger. In this mode each letter character typed to text box is sent to data 
logger and the response is automatically showed in this text box (like Microsoft HyperTerminal). It can 
be accessed by clicking the Terminal button. If settings of terminal mode were not loaded, a form will 
be shown.  
 

 
 
Choose the serial line number in the list. The additional arguments are optional. 
To change these settings click * button (which is located next to the Terminal button).  
 
 
Attention: If any parameter from the top is set to Default, the parameters below it will be ignored. 
 
 
Example 1: To set Stop bits to non-default, you have to define the Baud rate and Data bits to non-

default. 
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3.6 File Manager 
File Manager is used to view and work with files on remote data logger and local computer.  
 

 
 

3.6.1 Send or receive files 

To send or receive file select the files. Selected files can be dragged and dropped to another side of 
file manager. Also files can be copied to applications clipboard (Ctrl + C, Ctrl + V), so it is 

possible to copy files between data logger disks. Files can be transferred by clicking on Receive files 
or Send files buttons. In case of existing file in target directory the user is prompted to take an action. 
This can be overwriting, choosing another name or skipping the file. This action can be remembered 
for all files. 
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3.6.2 Receive configuration 

Configuration file (*.dat) on data logger is not shown in list, therefore it requires another method to 

receive file. In order to receive configuration file from data logger, click Receive config button. The file 

name in computer will be config.dat.  

 

3.6.3 Send configuration 

In order to send configuration file to data logger, select local file with .dat extension, click Send 

config button and then wait for file transfer to complete. If configuration file is dragged and dropped to 
data logger, then user can choose between sending file as regular file or as configuration file. 
In order to apply the configuration, additional Restart is needed on Advanced access screen. (See 
3.5.7 for details) 
 

3.6.4 Reload data logger files 

List of data logger files can be reloaded by clicking on Refresh button above the files on the left 
side (Data logger side). 
 

3.6.5 Delete files 

Files can be deleted by selecting the files and clicking on Delete button. Confirmation will appear. 
 

 
 

3.6.6 Rename file 

Rename operation on data logger is performed by copying source file to new name; therefore it may 
take longer, depending on file size. Local files are renamed immediately. To rename file, select the file 
to rename then click Rename button. 
 

3.6.7 Copy file 

The files can be copied from one disk to another within data logger using Ctrl + C or click Copy in 

source directory, then Ctrl + V or click Paste in destination directory. If the source and destination 

devices are different, then file transfer is initiated instead of copying. 
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3.7 Measurements 
On this page the measured quantities are shown. 
 

 
 

The quantities shown in AWS Service are the same as on the display of the data logger. This view is 
useful for connections over network or for data loggers without Touch LCD Display. 
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3.8 Station list 
AWS Service can maintain multiple stations. These stations can be automatically configured, what can 
be useful when data logger is replaced.  
 

 
 
Every Station must be associated with a Configuration type. This configuration type describes the 
operations related to the station. The configuration type has at least one Version of configuration. It is 
possible to Add new versions and Remove old versions for a configuration type, but at least one 
version should always remain. By changing a version of a configuration type all stations associated 
with this configuration type can access this new version. 
 
Configuration versions are created using AWS Setup program. Please refer to AWS Setup User’s 
Guide [2] for creation of data logger configurations. 
 
Stations are identified by an identification number (or text) 
New stations can be added by clicking Add Station button and removed by Remove button.  
To edit a station select a station from list and click Edit button. 
 

3.8.1 Add station / Edit station 

Add station view: 
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Edit station view: 
 

 
 
Name is the name of station which is shown in lists. Description can be longer text which helps to 
identify the station.  
 
Station ID is the value of identification variable in the data logger. Most commonly this variable is 

LOGID variable in the data logger, but the configuration may define another variable for the 

identification. If the variable is a numeric type (and the IDs are numbers), then do not include leading 
zeros in this field. (E.g. if the Station number is 7, enter value 7, and not 007). 
 
Configuration type is the type of the associated configuration. Some stations can share a common 
configuration type, some station have dedicated configuration types for just one station. If the 
configuration type is not in the list, you can add type by clicking Add Type button. For changing the 
name of configuration type, removing a type entirely or adding new versions to that type, click Edit 
Types button. See chapter 3.8.2 for details. 
 
If you entered all of the required fields, you can add a new station by clicking Add station button or 
update the currently edited station by clicking the OK button. By clicking Cancel button, no changes 
will be made (no new station and no changes in the existing one). 
 

3.8.2 Edit configuration types 

Some stations can share a common configuration type, some station have dedicated configuration 
types for just one station. So configuration type’s version is available in all associated stations. That 
means change of configuration version is needed only in one place. 
AWS Service supports multiple configuration types. You can Add new types, Edit, Remove them, add 
new versions (Add versions) of files or manage the versions (Edit Versions). 
 
Warning: By removing the configuration type, it will also remove the stations associated with this 

configuration type and their backups! 
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3.8.3 Add/Edit configuration type 

To add a new configuration type, the first configuration file should be defined. The versions of this file 
can be later edited. To select this file click on the rectangle below Select configuration file label, then 
select the file from the computer’s file system. This rectangle will indicate the currently opened file. If 
there is a problem with this file, the description of problem will be shown next to the rectangle. 
You can’t continue with creation of a new configuration type until a name and the file is not selected. 
 
 

 
 
 

 
 
The Name is the name of the configuration type which is shown in lists. Description can be longer 
text which helps to identify the configuration type. 
The upload feature is not available when editing the configuration type. Use Edit configuration 
versions instead. 
 

 
 

3.8.4 Edit configuration versions 

Every configuration type should have at least one version of the configuration. The version is identified 
by the creation date and time. There is also a comment which describes changes in the configuration. 
These two fields are included in the configuration file created by the AWS Setup program.  
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The Remove functionality is enabled just when there are at least two configuration versions. If there is 
only one remaining configuration version, it cannot be removed. 
To remove the last version, you have to remove the configuration type completely! Be careful with 
removing the configuration type, because it will also remove all associated stations and their backups. 
See chapter 3.8.2 for details. 
 

 
 

3.8.5 Add configuration version 

To select this file click on the rectangle below Select configuration file label, then select the file from 
the computer’s file system. This rectangle will indicate the currently opened file. If there is a problem 
with this file, the description of problem will be shown next to the rectangle. 
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3.9 Update firmware 
The data logger can contain up to 3 processors, which use software, which defines its tasks. This 
software is called firmware. MicroStep-MIS creates new firmware to support new data logger 
capabilities or fixing some issues. Every processor has its own firmware, which can be changed to 
newer version. 
 
The AWS Service can be used to change the firmware in 3 processors: 
 
Main processor: Its task is to log data, communicate with data collection system and user interface 
(Display, command line) and other tasks. 
The firmware file has .IEX file extension. The firmware file name is PIC3_<version>.IEX 

 
Measurement processor: Its task is to communicate with sensors, perform measurements and 

maintain power. The firmware file name is ATMEG<version>.HEX 

 
Serial extension: (Optional) Its task is to create additional communication channels. Available only for 
data loggers with this serial extension board installed. The firmware file name is 
SER_<version>.HEX 

 
The Update firmware screen detects the data logger’s file system for firmware files. The files can be 

even compressed, with extension .GZ. If the files are not present, use the File Manager to transfer 

the files into data logger’s disk E:. The recommended process is to use an external SD card with all of 

the files present. 
 

 
 
The actual version of the firmware is shown above the list of the available firmware files. For the serial 
card firmware it may show Not connected, if the serial extension is not installed. 
If you have a firmware selected, but you don’t want to update it, you can click Unselect button below 
the list. 
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Each processor has its progress dialog. This dialog is visible after expanding the expander. Before 
updating the firmware, ensure that good power source is connected (or batteries charged). The update 
process is started by clicking the Start button. It will update the firmware in the right order (Main 
processor last). Some updates may require change firmware in the measurement processor first. 
 
 

 
 
If the data logger is connected through service serial port, then a progress is shown for the update of 
the main processor. For other types of connection (USB port, Network) the progress is not available 
and the user has to wait long time, until the connection is available again. 
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If the update was successful, it is marked with green tick  sign next to the processor name. 
 

3.10  Communication 
Communication between data logger and computer is remembered when the communication log is 
turned on. This could be helpful when detailed information about logger’s behavior is needed. Select 
Communication from main menu to show the log view. To enable communication logging click 
Enabled button. Received data are red, sent data are green. 
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